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1 What Is Designation Card 
Manager?

The Designation Card Manager makes it possible for you to create 
designation cards to put on your Ericsson telephones. All you need 
is a PC and a printer. Designation Card Manager can be used both 
with Ericsson pre-cut papers, or with any paper your printer will 
take. A wide variety of standard labels for Ericsson telephones are 
available, and translations for several languages are included in the 
program.

Producing standard designation cards is a matter of a few key 
presses! And what’s more, you can edit each single key label, to 
enter extension numbers and names. You can even include 
symbols on the designation cards. No more hand-written labels on 
your telephones. A free selection of colors and text styles makes it 
easy to personalize your office telephones.

Note: On some telephones, the plastic cover over the 
designation card is transparent grey, which may change the 
appearance of colors.

1.1 Requirements
• Windows 98 Second Edition, Windows Me, Windows 2000 

(service pack 2 or higher), Windows XP (service pack 1 or 
higher) or Windows NT4 (service pack 4 or higher)

• TrueType font Arial required. Any additional TrueType fonts can 
also be used.

• A4 capable printer.
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2 How To Use the Designation 
Card Manager

2.1 Creating Designation Cards

To create a new designation card layout

From the File menu, Select New Card.

Make selections of language, telephone type etc.
When you see the generated telephone layout on your screen, you 
can edit each label.

Note: As the program does not supply all languages for all 
telephone types, some texts may appear in English even if 
you selected another language. However, you can edit 
these texts and type your own translation.

To edit text

Click on the text to edit.
Type your text, select font, color, horizontal and vertical alignment 
etc.

Add new texts in the empty fields.
You can press Tab to go to the next field.

The text fields are quite limited. Use a small text size to fit more 
text. You can break the text into more than one line. Always check 
the end result by a test print, since the design window does not 
show the exact output.
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To use images and symbols

Click the Image radio button.

Browse to find your icon or logo.
See section 2.8 Logos In the Image Directory .

To enter extension numbers (Dialog 3000 phones only)
You can enter an extension number on the extension number label, 
or you can let the Designation Card Manager create a running 
number series automatically during printout.

2.2 Saving Designation Cards

From the File menu, Select Save.

Save your designation cards on your computer or network 
drive.
It is a good idea to create sets of designation cards for your office, 
and saving them in a directory. By default, this is the Cards 
directory.

Note: If you are using a network drive to save your 
designation cards, the network drive must be mapped to a 
drive letter. Otherwise, printout will not work correctly. 
Please refer to your Windows help on how to map a 
network drive.

Storing and distributing designation cards
By setting up a library of ready-made designation card files, you will 
make it easy to reprint cards later, or to make copies for creating 
similar cards. It is also possible to create the cards on one 
computer, and move them to another computer for printout, as 
long as Designation Card Manager is installed on both computers.
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2.3 Printing Designation Cards

To print a single card
You can print the single card that you have created or opened. You 
can print on Ericsson pre-cut designation card papers, or any A4 
size paper.

Mark the checkbox for each of the card items that you want 
to print.
Depending on telephone type, you can select the designation 
cards for telephone and the additional key panels, and the cards for 
extension number and the pull-out leaf.

Click the Print button.
Now you can choose to print on standard paper or pre-cut paper. 
For pre-cut papers, it is recommended to perform an initial printer 
calibration. See section 2.7 Printer Calibration .

Printing using the Print Wizard
Using the Print Wizard, you can print cards for a selected 
telephone, without opening the file, or you can print all cards that 
you have saved in a directory. The Print Wizard also helps you to 
print an automatic numbering sequence for extension number 
cards.

2.4 Time-saving Features For Editing 
Designation Cards

To change the style for all text fields of a telephone

From the Edit menu, select Change Field Styles.
To be able to change a property, you must first activate the 
property.

Click the checkbox next to the property you want to edit.

Apply the changes by pressing Apply or OK.
If you choose Apply, you can undo the changes by pressing 
Cancel. If you choose OK, the changes are made and the window 
is closed.
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To re-use the style from one field to another

Edit a text field as appropriate.
Text size, alignment, font, color etc. The style settings are saved.

Click in another field which is empty and start to type.
The style of the previously selected field is applied to the new field.

To cut, copy and paste between fields
Any text or image in a field can be cut or copied and later pasted in 
another field by using the commands in the Edit menu or the 
equivalent keyboard shortcuts.

If you paste text in a field already containing some text, the format 
of the pasted text is ignored, i.e. the pasted text uses the same 
format as the text already written.

2.5 Creating Your Own Symbols
The Designation Card Manager can use any Windows bitmap file 
that you can create in your preferred image editing software. In 
order to make the image fit correctly on the designation cards, the 
images must be of the correct sizes, see page 7.

If the proportions are not correct, the Designation Card Manager 
will resize the image when importing, resulting in bad image quality.

To create an image

Find an image of the correct size in the Images directory.
Use this image as a template in your preferred image editing 
software. Or, you can create a completely new image of the correct 
size.

Edit the symbol as desired.

Make sure there is a one pixel black or grey dot in each of the 
upper left and lower right corners.
This is to assure white space around the symbol or icon. 
Otherwise, Designation Card Manager will size up the image to the 
edges of the field.
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Save the image under a new name.
If you do not want to save your images in the Images directory, 
please make sure that you save them in the same directory as 
where you put your corresponding cards.

Image sizes for Dialog 4000 phones
For example Dialog 4223, Dialog 4224 Operator, Dialog 4147 etc.

Image sizes for Dialog 3000 phones
For example Dialog 3213, 3212, 3214, Dialog 3185 etc.

490x57 pixels: For wide header images on the top of wide 
designation cards for Dialog 4224 Operator, 
Dialog 4225, 4425, 4422, 4222, 4220 and 
4147.

343x125 pixels: For narrow header images on the top of 
narrow designation cards for Dialog 4186
and 4223.

216x125 pixels: For symbols on Dialog 4224 Operator, 
Dialog 4225, 4425, 4422, 4222, 4220 and 
4147.

314x125 pixels: For symbols on Dialog 4186 and 4223.

572x125 pixels: For wide header images on the top of wide 
designation cards for Dialog 3213, Dialog 
3214

308x125 pixels: For narrow header images on the top of 
narrow designation cards for Dialog 3212, 
Dialog 3185.

375x38 pixels: For a low header image on the top of Dialog 
3210 designation card.

338x125 pixels: For symbols on the 3210 or analog 
telephones.

300x125 pixels: For symbols on other telephones and key 
panels.
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2.6 Using Pre-cut Paper
It is recommended to use Ericsson pre-cut papers. They have been 
perforated to make it easy to produce professionally looking 
designation cards for your Ericsson telephones. You can order 
them from your local Ericsson distributor, visit
http://www.ericsson.com/enterprise/contacts.shtml.

Name:
Position:
Company:
Address:
City:
Postcode: Country:
Tel: Fax:
Email:

Pre-cut designation papers in white, for Dialog 4000 telephones.
Quantity Article number Description

x20 LZTBS 160 021/1 Dialog 4224 Operator
x20 LZTBS 160 021/2 Dialog 4223, 4186
x20 LZTBS 160 021/3 Dialog 4225, 4425, 4422, 4222, 4220, 4147
x20 LZTBS 160 021/4 Key panel
x20 LZTBS 160 021/5 Pull-out leaf for Dialog 4224 Operator, 4225, 4425, 4223
x20 LZTBS 160 021/6 Pull-out leaf for Dialog 4422, 4222, 4220

Pre-cut designation papers in grey, for Dialog 3000 telephones.
Quantity Article number Description

x20 LZTBS 203 10/1 Extension number labels
x20 LZTBS 203 10/2 Dialog 3210
x20 LZTBS 203 10/3 Dialog 3211, Dialog 3212
x20 LZTBS 203 10/4 Dialog 3213, Dialog 3413, Dialog 3214
x20 LZTBS 203 10/5 Key panel
x20 LZTBS 203 10/6 Dialog 3145, Dialog 3146, Dialog 3185, Dialog 3186

http://www.ericsson.com/enterprise/contacts.shtml
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2.7 Printer Calibration
The position of a printout may be different on different printers. If 
you use Ericsson pre-cut papers, it is important that the printout is 
placed correctly inside the pre-cut designation cards. If you print on 
ordinary paper, you do not have to perform the calibration.

After your calibration is ready, the DCM program will store the 
adjusting values (x and y offset) on your computer. Therefore, you 
do not have to repeat the calibration, unless you change printer. It 
will be valid for all pre-cut papers.

Calibrate Scaling
Use this calibration feature if you need to compensate for any 
horizontal or vertical scaling error in your printouts. This is useful, 
because some printers may produce printouts, which are a little too 
large or too small.

Notes:
The calibration values will be stored in the file “TTDCM1.ini”, 
which is located in the Designation Card Manager program 
folder, or the Windows System folder. Make sure the file 
“TTDCM1.ini” is present and that it is not write-protected.

There is no need to discard a designation card paper that 
has been used for calibration. To avoid the upper left 
position, set the number of designation card copies to at 
least two.
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2.8 Logos In the Image Directory

Dialog 4000 phones
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Dialog 3000 phones
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2.9 Hotel Icons In the Image Directory

Dialog 4000 phones
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Dialog 3000 phones
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2.10 Creating Designation Cards for other 
telephones (Dialog 3201, Dialog 
3202 etc.)

You may be using a telephone which is not available in the 
Designation Card Manager. If that is the case, please select the 
corresponding telephone and adjust the designation card, as 
follows:

When you have selected your language and the corresponding 
telephone, the designation card is displayed in the design window 
of DCM.

Mark the header field of the card.

Click at "Text" above the card.
The header image disappears.

Type the name of the telephone, eg "Dialog 3202" and style 
the text as appropriate.

When printing the designation card, please use the pre-cut papers 
for the corresponding telephone according to the table above.

Your telephone Corresponding telephone

Dialog 3201 Dialog 3211

Dialog 3202 Dialog 3212

Dialog 3203 Dialog 3213
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3 The Import Wizard 
(BusinessPhone)

The Designation Card Manager can generate designation cards 
automatically, by importing data about the programmable keys. The 
BusinessPhone Management Suite (BMS) and the BusinessPhone 
Extension Assistant (BEA), article number FASBS 102 213/CD, are 
capable of exporting the type of text file that the Import Wizard can 
read. The data is located in a comma-separated file. The text file 
with data about the programmable keys is called a BMS export file. 
It is assigned a name starting with "DCMGEN" and the time of 
creation. File name extension is ".ext ".

3.1 Generating Cards by Using the 
Import Wizard

To start the import process

From the File menu, select Import Wizard.

Choose the folder where the BMS export file is located, and 
click Next.
A list of valid export files appears.

Select the file you want to import.
A list appears showing all phones and directory numbers (in 
brackets) found in the export file.

To avoid generating a card for a phone, select it and move it to the 
other list.
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Import language selection
The BMS export file has a preset BMS export language. However, 
you can change the language of the designation cards by selecting 
from a list.

Generated designation cards
When the designation cards have been generated, you can open 
and edit them as appropriate.

File name is "Generated-000.dcm ", where 000 is the extension 
number of each phone (asterisks (*) replaced by letter (A).

Note: If the report contains directory numbers where no 
card was generated, it is because there is no phone 
connected, or it is an unrecognised phone type, or a phone 
that does not have a designation card.

Adjusting the DCM export file
If you are not satisifed with the suggested texts in the cards, do this 
to avoid having to edit each single card:

Open the BMS export file in a text editor and modify the key 
texts until you are satisfied, taking care not to change any 
other information.

Run the Import Wizard again to create a new set of cards. 
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3.2 BMS Export File Structure
[General]

DCM file generated online/offline at 
yymmdd,hhmm by BMS user BMSuserid
Numberofphones=nnn
Language=selected export language 
Release=systemrelease
ModifiedKeyLayout=N/Y ........ (BMS 3.x, note 1)

[Phone1]
dirnum=dddd
teltype=DBCxxx
acdkeylayout=0/1/2 ........... (BMS 3.x, note 1)

text1=key#,function,assigned 
number,directory book entry,individual 
abbreviated number,text suggestion

text2=key#,function,assigned 
number,directory book entry,individual 
abbreviated number,text suggestion

text3=key#,function,assigned 
number,directory book entry,individual 
abbreviated number,text suggestion

text4=key#,function,assigned 
number,directory book entry,individual 
abbreviated number,text suggestion

[Phone2]
dirnum=dddd
teltype=DBCxxx
acdkeylayout=0/1/2

text1=key#,function,assigned 
number,directory book entry,individual 
abbreviated number,text suggestion

text2=key#,function,assigned 
number,directory book entry,individual 
abbreviated number,text suggestion

…

[End]

Note: 1) Only valid for BMS 3.x
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3.3 Description of the BMS Export File 
Contents

Notes:
(1) Only valid for BMS 3.x
(2) The comma-separation must be correct on the line even 
if an item is blank. However, if neither a function nor an 
individual abbreviated number is specified for the numbered 
key, the whole line can be omitted.
(optional) Optional item not used by the Import Wizard.

Property Description Note

online/offline Indicates if the file was generated running an online or 
offline programming session

(optional)

yymmdd,hhmm Date and time of file creation (optional)

BMSuserid Identification of the BMS user who created the file (optional)

Numberofphones=nnn Counter for the number of extensions included in the file (optional)

selected export 
language

Language of the exported data from the exchange, e.g. 
"EN" for English. You can change language during import.

systemrelease Release of the originating exchange

ModifiedKeyLayout N (No) indicates that telephone types DBC220, DBC 222 
and DBC223 use key layout from before Release 8.

(BMS 3.x, 
note 1)

dirnum=dddd Internal directory number of an extension

DBCxxx Type of telephone physically connected

acdkeylayout 1 indicates ACD layout with clerical key, 2 indicates ACD 
layout without clerical key, else standard layout

(BMS 3.x, 
note 1)

text1=key#,... Per-key descriptions containing all necessary information. 
The line starts with ‘text#=’, where # is a counter starting 
with 1 and is incremented by 1 up to the last defined key 
per handled extension

(note 2)

function Name of function (optional)

assigned number Number associated to the function (optional)

directory book entry Entry in the telephone system directory (optional)

individual abbreviated
number

Abbreviated number programmed on the key, which will 
be put on the card

(optional)

text suggestion The text that will be put on the card
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3.4 Examples For Key Definitions
text1=key1,Supervision,3401,BOB 
BURNES,0049123454410,Sup BOB BURNES

• Supervision of extension 3401 is programmed on the first key.

• ‘BOB BURNES’ is stored in the directory book for extension 
3401.

• 0049123454410 is programmed as individual abbreviated 
number on the key, and will be put on the designation card on 
that key.

• ‘Sup BOB BURNES’ is the suggested text that will be put on the 
designation card on that key.

text2=key3,Name 
selection,3402,,00491888221275,Call 3402

• Name selection for extension 3402 is programmed on the third 
key.

• No name is stored in the directory book for extension 3402

• 00491888221275 is programmed as individual abbreviated 
number on the key, and will be put on the designation card on 
that key.

• ‘Call 3402’ is the suggested text that will be put on the 
designation card on that key.

text3=key4,,,,00491888221276,

• No function assigned on the fourth key.

• 00491888221276 is programmed as individual abbreviated 
number on the key, and will be put on the designation card on 
that key.

• No suggested text since no function is defined.
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